Field Application Tool – User Management

User Guide

Distributed Tactical Communications System (DTCS)

December 2009
Version SW1.3
# TABLE OF CONTENTS

Section 1 – User Management ................................................................................................................................. 1  
  1.1 Purpose .................................................................................................................................................. 1  
  1.2 Background ........................................................................................................................................ 1  

Section 2 – Preparation for Using User Management ............................................................................................. 2  
  2.1 Receiving Your User Name and Password .......................................................................................... 2  
  2.2 Setting Up the User Management Application .................................................................................. 2  
  2.3 Logging Into the User Management Application ............................................................................ 3  

Section 3 – User Management Screen Layout ......................................................................................................... 4  

Section 4 – Configuring Handsets with Nets .......................................................................................................... 7  
  4.1 Querying Net Manager ....................................................................................................................... 7  
  4.2 Assigning a Net to a Handset .......................................................................................................... 9  
  4.3 Assigning a Handset to a Net ............................................................................................................. 11  
  4.4 Change Net Order on a Handset ....................................................................................................... 11  
  4.5 Verification ....................................................................................................................................... 12  
  4.6 Unassignment .................................................................................................................................... 13  
  4.7 Submitting Net Requests .................................................................................................................. 13  
  4.8 Editing Handset Settings ................................................................................................................... 16  
  4.9 Editing Net Settings ......................................................................................................................... 18  
  4.10 Making User Assignments ............................................................................................................ 19  

Section 5 – Additional Functionality ...................................................................................................................... 24  
  5.1 Find ................................................................................................................................................... 24  
  5.2 History ............................................................................................................................................... 24  
  5.3 Property Information ........................................................................................................................ 25  
  5.4 Help .................................................................................................................................................. 25  

Section 6 – Using the Map ...................................................................................................................................... 27  
  6.1 Selecting a Map Layer ....................................................................................................................... 27  
  6.2 Map Controls ..................................................................................................................................... 27  
  6.3 Drawing Nets ...................................................................................................................................... 28  
  6.4 Making Assignments with the Map ................................................................................................... 30  
  6.5 Map Display Filtering ........................................................................................................................ 30  

Section 7 – Using User Management to Troubleshoot Handsets ............................................................................ 33  
  7.1 Getting IMEI and Software Load Information .................................................................................. 33  
  7.2 Checking Data Usage ........................................................................................................................ 34  
  7.3 Using AT Utility to Determine Handset Configuration .................................................................... 34  
  7.4 Error Logs ......................................................................................................................................... 35  

Section 8 – Updating Password, and Delegated Handsets and Nets ........................................................................ 38  
  8.1 Changing Password ........................................................................................................................... 38  
  8.2 Exporting Data for Remote Delegation ............................................................................................ 38  
  8.3 Importing Data for Remote Delegation ............................................................................................ 39  

Appendix ............................................................................................................................................................ 41  
  Abbreviations ........................................................................................................................................... 41
# TABLE OF FIGURES

- Figure 1: DTCS Radio and User Management Laptop Setup ........................................... 2
- Figure 2: Login Window ................................................................................................ 3
- Figure 3: User Management Screen Layout ................................................................. 4
- Figure 4: Submittal Tab when Querying ......................................................................... 7
- Figure 5: Query Net Manager Window ......................................................................... 8
- Figure 6: Handset Properties Window .......................................................................... 9
- Figure 7: Handset Net Assignment Override Windows ................................................ 10
- Figure 8: Net Properties Window ................................................................................ 11
- Figure 9: Changing Net Order in the Handset Properties Window ............................... 12
- Figure 10: Submittal Tab .............................................................................................. 14
- Figure 11: Reviewing a Partial Success Submittal ....................................................... 16
- Figure 12: Editing Handset Settings in the Handset Properties Window ....................... 17
- Figure 13: Editing Net Settings in the Net Properties Window ..................................... 19
- Figure 14: Add New Command Level Window .............................................................. 20
- Figure 15: Add New User Window .............................................................................. 20
- Figure 16: User Tree Pane .......................................................................................... 21
- Figure 17: User Properties Window .......................................................................... 22
- Figure 18: Find Window ............................................................................................. 24
- Figure 19: Example History Information ..................................................................... 25
- Figure 20: Help Window ............................................................................................ 26
- Figure 21: Load Map Layer Window .......................................................................... 27
- Figure 22: Map Area with Map Controls .................................................................... 28
- Figure 23: Select a Net to Assign to Region Window .................................................. 29
- Figure 24: Selecting a Net on the Map Between Multiple Options ............................... 30
- Figure 25: Declutter Nets Window ............................................................................ 31
- Figure 26: Filtering the Display of Nets on the Map .................................................. 31
- Figure 27: Map View with Net/Handset Layer Filtering ............................................ 32
- Figure 28: Attached Handset Properties Window ...................................................... 33
- Figure 29: AT Utility Window ................................................................................... 35
- Figure 30: Saving Export File for Remote Delegation ................................................ 39
- Figure 31: Importing File for Remote Delegation ....................................................... 40
Section 1 – User Management

1.1 Purpose
To provide users of the Distributed Tactical Communications System (DTCS) User Management portion of the Field Application Tool (FAT) with a user guide that illustrates the basic tasks and procedures.

1.2 Background
The Distributed Tactical Communications System (DTCS) is an experimental, satellite-based, communications system that incorporates Iridium satellite technology, software, and commercial GPS. DTCS was developed in direct response to the needs of the warfighter to explore new and innovative Command and Control (C2) technology. DTCS provides Beyond Line-Of-Sight (BLOS), Over-The-Horizon (OTH), and On-The-Move (OTM) communications, in a handheld, lightweight, one-to-many, tactical voice and data radio.

The User Management (UM) portion of the Field Application Tool (FAT) provides a flexible, Graphical User Interface (GUI)-based method for managing DTCS radios. Based on the Communications Electronics Operating Instruction (CEOI), you will know what the directed function of each DTCS net is, which nets you have been delegated the capability to participate in, and which nets you not only participate in but also serve as the “owner” or manager. The primary function of User Management is to assign from the DTCS nets that are available to you, the specific nets that you want to provide on each of your DTCS radio handsets. In doing so, you also assign the order in which they should appear on the handset’s Net Selection knob. These assignments are then submitted via the attached handset to the Net Manager (NM), where the changes are actually made. The Net Manager will verify the net-handset assignments you requested match the current nets and handsets delegated for your user account and will then execute the changes. Feedback is provided in User Management on whether this process was successful, or any issues that might have arisen.

In addition, User Management provides the capability to build user and command structures to assist in asset management and distribution. A map function is also available as a visual aid in assigning nets to units operating over larger geographical areas.

In the future, the FAT application will be expanded beyond User Management to assist with detailed scenario-based planning. It will include DTCS satellite modeling to provide satellite coverage predictions which account for time, terrain, and location.
Section 2 – Preparation for Using User Management

2.1 Receiving Your User Name and Password
A DTCS Field Service Representative (FSR) will provide a user name and password for your Field Application Tool – User Management account. This user name and password must remain in sync with your user name and password on the Net Manager. If the User Management and Net Management account information are out of sync, you cannot send your requested changes to Net Manager and they cannot be made.

NOTE: Do not change your User Management password unless this is coordinated with an FSR (see Section 8.1 Changing Password).

2.2 Setting Up the User Management Application
- Attach the power adapter to the User Management computer.
- Attach the power adapter to the RO or ROA handset, or ensure it has batteries.
- Connect the flash cable from the handset’s 6-pin connector to the computer’s serial port. NOTE: If no serial port is available, use the additional serial-to-USB cable to connect to the laptop’s USB port.
- Turn on the handset.
- Turn the handset Volume/Function knob to Function Mode. It should be at position F1 on two-position knobs. For knobs without the F1/F2 positions, turn the knob to the lowest setting before Off to enter Function Mode.
- On the handset, turn the Net Selector knob to net 7.

[Image: Figure 1: DTCS Radio and User Management Laptop Setup]
2.3 Logging Into the User Management Application

- Turn on the computer and double-click the User Management icon on the desktop.
- Type in your User Name and Password.
- Click on the Log In button.

![Login Window](image)

**Figure 2: Login Window**

NOTE: If either the User Name or Password is incorrect, an error message will be displayed that says “INCORRECT User name or Password!” User Name and Password are case-sensitive. If you get the incorrect password error message, try checking capitalization.
Section 3 – User Management Screen Layout

1) **Logged in User** – The name of the user that is currently logged into the User Management tool.

2) **Menu Bar** – The menu provides access to a number of User Management functions. See below for the available actions under each menu item.
   - **File**
     - Administrator Log In
     - Change Password (see section 8.1)
     - Exit
   - **View**
     - Declutter Nets (see section 6.5.1)
   - **Edit**
     - Find (see section 5.1)

*Continued on next page*
Map Layer
- Load Map Layers (see section 6.1)
- Save Visible Map [future functionality]
- Print Visible Map [future functionality]

Tools
- Query Net Manager (see section 4.1)
- Attached Handset (see sections 7.1 and 7.2)
- AT Utility (see section 7.3)

Logging
- View Log File (see section 7.4.1)
- Clear Log File (see section 7.4.2)
- Export Log File (see section 7.4.3)

Delegation
- Import My Updated Data (see section 8.3)
- Export My Updated Data (see section 8.2)

Help
- Help (see section 5.4)
- About

3) Current Domain – In this version users are expected to only be assigned one domain, so changing domains will not be required.

4) Assignment – The tab where assignments can be made between users, nets, and handsets.

5) Submittal – The tab where changes made on the assignment tab are submitted and feedback on the submittals is displayed. In addition, handsets can be refreshed from here.

6) Users – This pane can be populated with individual DTCS users which can then be assigned to a specific handset(s) if desired.

7) Nets – This pane lists the nets available to be assigned.

8) Handsets – This pane lists the IMEIs of available radios.

9) Find – This is a keyword search function. Search items and results are presented in a pop-up window.
10) **History** – This pane provides a log of all actions performed during the current session.

11) **Property Information** – This pane provides information about the currently selected net, handset, or user.

12) **Map** – The map provides a visual aid for net planning and assignment.
Section 4 – Configuring Handsets with Nets

4.1 Querying Net Manager

If you are not sure if changes have been made to the handsets or nets delegated to your user name, it is recommended that you query the Net Manager prior to beginning. This will ensure that information you are working with is the most up-to-date, and minimize the chance of errors. To query the Net Manager for the latest settings, use one of the two following procedures:

- Click on the **Submittal** tab.
- Verify the connected handset is listed (see Figure 4). If not, click on the **Refresh Handsets** button.
- Click on the **Query Net Manager** button to bring up the **Query Net Manager** window (see Figure 5).
- Select the handsets or nets you want to ensure are in sync with the latest updates from Net Manager. Use the arrows to move the selected handsets and nets to query to the lists on the right side.
- When complete, click on the **OK** button. This will return you to the **Submittal** tab (see Figure 4).
- Click on the **Submit Requests** button.

![Figure 4: Submittal Tab when Querying](image-url)
OR

☐ Click on the **Tools** menu selection.

☐ Select the **Query Net Manager** option to bring up the *Query Net Manager* window (see Figure 5).

☐ Select the handsets or nets you want to ensure are in sync with the latest updates from Net Manager. Use the arrows to move the selected handsets and nets to query to the lists on the right side.

☐ When complete, click on the **OK** button.

☐ Click on the **Submit** tab.

☐ Verify the connected handset is listed (see Figure 4). If not, click on the **Refresh Handsets…** button.

☐ Click on the **Submit Requests** button.

![Figure 5: Query Net Manager Window](image)

Within the **Submit** tab screen, the **Ending State** section will be blank because no changes are being requested. Each net(s) or handset(s) selected for the Net Manager query will be listed under the **Updates** section. The status of the communication with the Net Manager is provided under the **Configuration Request Messages Queue** section. If you are able to communicate with the Net Manager the status will be noted as Success. If not, it will display an error message. If each handset(s) or net(s) queried is in sync with the Net Manager, a Success message will also be displayed in the status provided in the **Updates** section. If a handset or net only partially matches the settings on Net Manager, a Partial Success message will be displayed. You can click on the **Partial Success** to open a window with additional details. For more information on interpreting the **Submit** tab, see section 4.7 Submitting Net Requests.

The **Submit** tab will not show what if any changes to nets or handsets are pulled from Net Manager. Review the **Assignment** tab to see the latest information.
4.2 Assigning a Net to a Handset

Additional methods for making assignments can be found in section 4.10.5 Assigning Handsets to Users and section 6.4 Making Assignments with the Map.

4.2.1 Assigning a Net to a Handset through Handset Properties

The preferred method for assigning nets to a handset is through the Handset Properties window. To assign with this method, use the following procedure:

- Right-click on an IMEI in the Handsets pane.
- Select Properties from the right-click menu to bring up the Handset Properties window (see Figure 6).
- Click on the net(s) you want to assign in the Available Nets box and use the arrow to move it (them) to the Nets Assigned to Device box.

NOTE: The nets will be loaded onto the radio in the order they are added to the Nets Assigned to Device box (i.e. the net corresponding to “1.” in the Nets Assigned to Device box will be on the 1st position of the radio’s Net Selector knob, the net corresponding to “2.” will be on the Net Selector knob’s 2nd position, and so on). A maximum of five nets can be assigned to each handset.

- When complete, click on the OK button.

![Figure 6: Handset Properties Window](image)
NOTE: Once a change has been made to a net or handset IMEI, it will become bold and highlighted in red in the **Nets** or **Handsets** pane respectively (see Figure 19). This change in font and color is to indicate that a change has been made, and the current configuration in the FAT UM no longer matches the last known configuration for that handset or net at the Net Manager. Once these changes have been submitted successfully on the **Submittal** tab, the net or handset IMEI will return to its original font and color.

### 4.2.2 Assigning a Net to a Handset using Drag and Drop

As an alternative, the drag and drop method may be used. To assign a net with this method, use the following procedure:

- Left-click and hold on a net in the **Nets** list until there is a small plus sign next to the cursor to visually indicate that the dragging function is active.
- Drag the net to the IMEI in the **Handsets** list you want to assign it to.

**NOTE:** Multiple selections can also be assigned using drag and drop. For example, multiple handsets can be highlighted and dragged together to assign to a net.

### 4.2.3 Maximum of Five Nets Per Handset

If you try to add more than five nets to any handset, the dialog box on the left in Figure 7 will appear and you will have the option of manually or automatically overriding the net assignments. If you select manual selection, then the next dialog box (on right) will allow specific nets to be added or deleted from the set. If you select automatic overriding, the nets at the end of the net order list will be replaced (working from position 5, then 4, etc.) with the new nets you were in the process of adding to the handset when the maximum was exceeded. So if nets 1, 2, 3, 4 and 5 were added previously and you choose to automatically override them with nets 6 and 7, then the final set of nets will be 1, 2, 3, 6 and 7.

![Figure 7: Handset Net Assignment Override Windows](image-url)
4.3 Assigning a Handset to a Net

If desired, you can also make assignments by assigning handsets to nets. The process parallels nets to handsets as described above. Assignments can either be made by right-clicking on the net to access Properties, and making changes in the handsets assignments at the bottom of the Net Properties window (see Figure 8). Alternately, you can also drag a handset or multiple handsets from the Handsets list up to the desired net in the Nets list.

![Figure 8: Net Properties Window](image)

4.4 Change Net Order on a Handset

To verify or change the order in which nets will appear on a handset’s Net Selector knob, use the following procedure:

- Right-click on an IMEI in the Handsets pane.
- Select Properties from the right-click menu to bring up the Handset Properties window (see Figure 9).
- Use the arrows on the far right to move the nets up and down in the list.

As noted previously, the net corresponding to “1.” in the Nets Assigned to Device box will be on the 1 position of the radio’s Net Selector knob, the net corresponding to “2.” will be on the Net Selector knob’s 2 position, and so on.

- When complete, click on the OK button.
4.5 Verification

Once nets have been assigned, you may want to verify assignments before submitting the changes. This can be done by net or by handset IMEI.

4.5.1 Verification by Net

- Right-click on a net in the **Nets** list.
- Select **Properties** from the right-click menu to bring up the **Net Properties** window (see Figure 8).
- Use **Handsets Assigned to Net** box to verify that all the desired IMEIs are assigned to this net. If the list is incorrect, IMEIs may be added or removed by highlighting the IMEI and using the arrows to move it.
- When complete, click on the **OK** button.

4.5.2 Verification by Handset IMEI

- Right-click on an IMEI in the **Handsets** pane.
- Select **Properties** from the right-click menu to bring up the **Handset Properties** window (see Figure 6).
- Use **Nets Assigned to Device** box to verify that the appropriate nets are assigned to this handset. If the list is incorrect, nets may be added or removed by highlighting the net and using the arrows to move it.
- When complete, click on the **OK** button.
4.6 Unassignment
If an incorrect net or handset assignment is made, or if a net is no longer required on a particular handset, use the following procedures to unassign nets or handsets.

4.6.1 Unassign Nets
- Right-click on an IMEI in the Handsets list.
- Select Properties from the right-click menu to bring up the Handset Properties window (see Figure 6).
- Click on the net you want to unassign in the Nets Assigned to Device box and use the left arrow to move it to the Available Nets box.
- When complete, click on the OK button.

4.6.2 Unassign Handsets
- Right-click on a net in the Nets list.
- Select Properties from the right-click menu to bring up the Net Properties window (see Figure 8).
- Click on the handset you want to unassign in the Handsets Assigned to Net box and use the left arrow to move it to the Available Handsets (IMEI) box.
- When complete, click on the OK button.

4.7 Submitting Net Requests
All of the net, handset, and user information assignments made in the Assignment tab are stored locally on the computer. However, at some point the changes will need to be submitted through the network to be permanent. Submitting requests sends the assignments (or the query request) to the Net Manager, where the actual changes are made. From the Submittal tab you can see the status of all the requests that are to be or have already been submitted. This information will stay on the Submittal tab until the session is exited. To submit assignment requests to the Net Manager, use the following procedure:

- Click on the Submittal tab.
- Verify the connected handset is listed (see Figure 10). If not, click on the Refresh Handsets… button.
- Click on the Submit Requests button.
4.7.1 Interpreting the Submittal Feedback

When updates are submitted there is a potential for overlaps or conflicts. For example, a conflict occurs when an assignment is contrary to an assignment which has already taken place, such as adding net to a radio which has already been deleted. Feedback messages are provided to assist in successfully resolving these issues.

Information under Ending State shows what the end result will be of all the changes you are requesting to the net or handset assignment. In the Ending State changes are grouped by handset (if there is a related handset), and within a handset all the changes of one type (e.g. net changes, PLI changes) will be grouped together on one row. If there are changes just to a net (e.g. TTL), that net will display on its own row.
Information under **Updates** shows the individual assignment updates that are in the queue to send to Net Manager or have recently been sent. These updates are all listed by handset, unless it is a net only change. All the changes are listed in their own rows. The status of the response from Net Manager for each update is provided in the column on the right. The potential **Status** results are:

- **Pending**
  
  Still waiting for a response. This will also appear if there is a failure in the satellite connection.

- **Success**
  
  All the changes have been accepted. Provided there are no conflicts, this will be the usual message.

- **Partial Success**
  
  Some of the individual changes have been accepted. See section 4.7.2 for more information.

- **Failed**
  
  None of the changes have been accepted. You may want to query the current state of the attached handset in order to determine the problem.

The **Configuration Request Message Queue** section provides information about the communication with Net Manager, where each submittal gets a unique Message Number. The potential Status messages are the similar to those above. It is important to note that a Success message here does not mean that the requested changes were made. This only conveys that you were successfully able to send your information to the Net Manager. Whether or not the requested assignment changes were successful is displayed in the **Updates** section.

If you get a red error message in the **Configuration Request Message Queue** section that says Authentication Failed, this means that your User Management user name and password did not match your Net Manager user name and password. Contact your FSR to ensure you have the latest password for your account on Net Manager.

### 4.7.2 Reviewing a Partial Success

The submittal process may result in a partial success, where some of the assignment changes were completed and some failed. If this happens, you can click on the Partial Success status to open the **Handset Partial Update** window (see Figure 11). This window lists each setting requested and what it was updated to on the Net Manager. A partial success occurs if there are any cases where these items do not match. If so, the row will be highlighted in red. In the Figure 11 example, net 200 was requested for the handset but net 200 was no longer included in the list of nets delegated to this User Management user at the Net Manager. Click on the in the upper right to close the window.
4.8 Editing Handset Settings

Certain properties can be set for each handset. These include whether Netted Iridium in enabled, whether Position Location Information (PLI) is enabled, and what the PLI reporting parameters should be.

4.8.1 Enable/Disable Netted Iridium Mode

Under normal circumstances, Netted Iridium mode should always be enabled. If this feature is disabled, the radio will not be able to transmit/receive voice, data, or PLI. If Netted Iridium mode has been disabled, it can be enabled using the following procedure:

- Right-click on an IMEI in the Handsets list.
- Select Properties from the right-click menu to bring up the Handset Properties window (see Figure 12).
- Check the box next to Netted Enabled to turn Netted Iridium mode on.
- When complete, click on the OK button.
NOTE: Do not uncheck the **Netted Enabled** checkbox. If Netted Iridium mode is disabled, the radio will not be able to communicate with the Net Manager and will not be able to be used to communicate on any nets.

4.8.2 Enabling/Disabling Position Location Information (PLI)

PLI can be turned on or off for each of the radios in the **Handsets** list. There is no difference to the handset user in the operation of the handset, but if PLI is not enabled the handset’s position will not be displayed on the PLI Collector map. By default PLI is enabled so that the PLI information will be displayed in PLI Collector. However, if the radio user needs his or her position to remain undisclosed, for example due to covert operations, then PLI can be disabled. To turn PLI on/off, use the following procedure:

- Right-click on an IMEI in the **Handsets** list.
- Select **Properties** from the right-click menu to bring up the **Handset Properties** window (see Figure 12).
- Check the box next to **PLI Enabled** to turn PLI on. Uncheck the box to turn PLI off.
- When complete, click on the **OK** button.
4.8.3 PLI Reporting Parameters
PLI triggers can be set so that PLI information is automatically reported on a given time interval or if the radio’s position changes. To change the values of the PLI reporting triggers, use the following procedure:

□ Right-click on an IMEI in the Handsets list.
□ Select Properties from the right-click menu to bring up the Handset Properties window (see Figure 12).
□ To change how frequently PLI is reported enter a value in seconds (minimum 60 s) in the Time Interval Report Every box.

NOTE: The default time to interval report is 60 seconds.
□ To report PLI when a radio’s position changes enter a value in meters (minimum 20 m) in the Report On Movement box.

NOTE: The default report on movement distance is 20 meters.
□ When complete, click on the OK button.

4.9 Editing Net Settings
The only net property that can be configured is the Time To Live (TTL) of the net. CAUTION – Remember these may be shared nets. Only the “owner” of the net should change the net properties.

4.9.1 Time To Live (TTL)
The Time To Live (TTL) setting for the net controls when the encryption keys will expire (see Figure 12). To change the TTL setting, use the following procedure:

□ Right-click on a net in the Nets list.
□ Select Properties from the right-click menu to bring up the Net Properties window (see Figure 13).
□ To change the net TTL, enter a time in days and hours (minimum 1 hour up to a maximum of 365 days).

NOTE: The default TTL is 12 hours.
□ When complete, click on the OK button.
4.10 Making User Assignments

4.10.1 Building the User List

If desired, you can also build a list of DTCS handset users to assist in managing the handsets and nets. Commands and users can be added in a hierarchical structure to build a DTCS user tree. Levels of this user list or tree can be expanded or collapsed to tailor the visual presentation.

4.10.2 Creating Commands

Commands are a structural user classification which designates branches in the user tree. In order to add users, at least one command level must be created so users can be added under it in the hierarchy. For extensive radio groups in a domain, multiple command levels can aid in distinguishing and separating the individuals. Also, multiple command levels make it easy to establish group nets and can improve assignment efficiency. Right-clicking on a command allows you to rename the command level.

To create a command, use the following procedure:

- Right-click on your user name (or a command if already created) in the Users list.

NOTE: Commands can only be added under you as the User Management user or to other commands, but not under other DTCS users in the user list.
Select Add New Command from the right-click menu to bring up the Add New Command Level window (see Figure 14).

Complete the Unit Name and Unit designation for the command you want to create.

When complete, click on the OK button.

4.10.3 Adding Users
Individual DTCS users can be added under commands. These users can be either personal names, or unit names can be substituted in the First and Last name fields. Once people or units are in the Users list, handsets and/or nets can be assigned to them. This enables you to see and manage which users will have access to which handsets and nets. User information is for your planning purposes only and is not submitted to the Net Manager. To add a user, use the following procedure:

Right-click on a command in the Users list.
Select Add New User from the right-click menu to bring up the Add New User window (see Figure 15).
Complete the information for the user you want to create. The First and Last user name and URN fields are required entries. All other fields are optional.
When complete, click on the OK button.
4.10.4 Expanding and Collapsing the User Tree Pane

Within the user tree, you can expand or collapse individual “branches” to tailor your view (see Figure 16). If there is a plus sign next to a user or command, you know there are additional users underneath. Clicking on the plus sign opens the next level down in the hierarchy. You can collapse levels in the hierarchy by clicking on the minus sign next to a command or user. This will collapse all information under that level.

![Figure 16: User Tree Pane](image)

4.10.5 Editing User Settings

From the *User Properties* window, you can view and edit the user’s information that was inputted when the user was first created (see Figure 17). You can also see available handsets, assign handsets, and see the nets associated with the handsets currently assigned to the user. To access user properties, use the following procedure:

- Right-click on a user in the *Users* list.
- Select **Properties** from the right-click menu to bring up the *User Properties* window (see Figure 17).
- When completed, click the **OK** button.
4.10.6 Assigning Handsets to Users

Handsets can be assigned to users in the user tree. To make a user handset assignment, use the following procedure:

- Right-click on a user in the Users pane.
- Select Properties from the right-click menu to bring up the User Properties window (see Figure 17).
- Click on the handset(s) you want to assign in the Available Handsets (IMEI) box and use the right arrow to move it (them) to the Handsets Assigned to User box.

NOTE: Within the User Properties, you can also review all the nets that are assigned to that user. However, nets cannot be assigned to a user from the User Properties window. The assignment connection must be made through the handset associated with both the user and the net.

Alternately, you can drag and drop between handsets or nets and users to make assignments. The User Selection Window appears after each net assignment is dragged to a user. In this window you select the specific users (or their assigned handsets) to which you want to assign the net. Click on the minus sign next to the user to see all the items below in the hierarchy. Check or uncheck boxes as desired to make the net assignment. Any user or handset with a check will be assigned the net.
NOTE: By default all elements in the hierarchy under the user that you dragged the net to are checked and will be assigned the net. You should go through and uncheck any command, users, or handsets under the user you dragged to that should not receive the net.
Section 5 – Additional Functionality

5.1 Find
The Find function provides a keyword search capability. It searches across all fields in the User Management application and returns any matches in the results. From the results you can double-click on any of the items to open its Properties window. To use the find functionality, use one of the two following procedures:

☐ Click on the Tools menu selection.
☐ Select the Find option to bring up the Find window (see Figure 18).
☐ Enter your search term in the text field at the top and click on the Search button.
☐ Click on the [X] in the upper right to close.

OR

☐ Click on the Find button located to the left below the map. This will also bring up the Find window.
☐ Enter your search term in the text field at the top and click on the Search button.
☐ Click on the [X] in the upper right to close.

Figure 18: Find Window

5.2 History
The history pane is located on the Assignment tab to the right of the Handsets pane (see Figure 19). This pane shows a time stamped log of all actions performed during the current User Management session. History provides positive feedback that an action has taken place as well as offering another method for the user to go back and verify changes made previously in the session (for additional methods of verifying net
assignments see section 4.5). Once the user logs out or closes the User Management program, the history pane is cleared.

5.3 Property Information

This pane is located on the bottom right of the User Management main window. The Property Information pane provides information about the currently selected net, handset, or user. Scroll down with the scroll bar on the right to view the complete set of properties. This is the same type of information that is provided on the individual Net, Handset, or User Properties windows, but it is shown in a different format and does not require going through the right-click menu.

5.4 Help

Additional information is provided in the User Management application within the Help functionality (see Figure 20). The Help is an interactive tool for learning about features or clicking on items in the interface to bring up more information. To use the Help functionality, use the following procedures:

- Click on the Help menu selection.
- Select the Help option to bring up the Help window (see Figure 20).
- Click on the in the upper right to close.
Figure 20: Help Window
Section 6 – Using the Map

6.1 Selecting a Map Layer
When loading a map, you can select from the available map missions or regions and within these, you select which details (e.g. elevation, boundaries and roads) or “layers” of the map you want to display. Additional layers may provide more information, but they also increase the clutter on the map display and slow the application processing. To select which map layers you want to display, use the following procedure:

- Click on the Map Layer menu selection.
- Select the Load Map Layers option to bring up the Load Map Layer window (see Figure 21).
- Navigate the Missions and Regions hierarchy on the left side to select your map.
- Then check or uncheck the layer options on the right side to select which ones you want to display.
- When completed, click on the Load button.

![Figure 21: Load Map Layer Window](image)

6.2 Map Controls
A grouping of iconic map controls is provided in the upper left of the map area (see Figure 22). The functions of the controls are as follows:

- **Pan Map** – Used to grab and move the map within the view pane.
- **Zoom Selection** – Used to zoom in on a rectangular area defined by the user.
- **Center Map** – Used to zoom out to fit the entire map into the view pane.
- **Zoom In** – Used to zoom in slightly.
- **Zoom Out** – Used to zoom out slightly.
**Net/Handset Selection and Modification** – This tool allows the user to select a specific net or radio on the map. This tool can also be used to alter the points of a net drawing.

**Draw Elliptical Net** – This tool allows the user to draw an ellipse on the map to represent a net.

**Draw Polygonal Net** – This tool allows the user to draw a polygon on the map to represent a net.

---

6.3 Drawing Nets

Nets can be represented on the map pane as either ellipses or polygons. These can then be used as a planning tool or to actually assign IMEIs to available nets.

NOTE: Nets drawn on the map are graphical representations ONLY. The boundaries of nets drawn on the map do not represent or affect the range offered by DTCS. Drawing nets is intended as an aid when managing net assignments that are being made based on political boundaries or areas of responsibility.

6.3.1 Elliptical Nets

To draw an elliptical net in the map pane, use the following procedure:
- Left-click on the **Add Elliptical Net** map control to select.
- Left-click desired starting point. This is the starting edge of your net boundary.
- Drag the mouse to stretch the ellipse to the desired size and shape and release the left mouse button.
- The *Select a Net to Assign to Region* window will appear displaying available nets (see Figure 23).
- Select the net that this ellipse will represent from available list.
- When complete, click on the **OK** button.

![Figure 23: Select a Net to Assign to Region Window](image)

### 6.3.2 Polygonal Nets

To draw a polygonal net in the map pane, use the following procedure:

- Left-click on the **Add Polygonal Net** map control to select.
- Left-click on the map to designate the starting point of the polygon.
- Left-click on successive points to define the boundary of the polygon.
- Right-click on the final point to complete the polygon.
- The *Select a Net to Assign to Region* window will appear displaying available nets (see Figure 23).
- Select the net that this polygon will represent from available list.
- When complete, click on the **OK** button.
6.4 Making Assignments with the Map

6.4.1 Assign Handsets to Nets Using the Map
Once one or more nets have been drawn on the map, handsets can be assigned by dragging them to the appropriate net using the following procedure:

☐ Left-click and hold on an IMEI in the Handsets list.
☐ Drag the IMEI to the map and place it inside the boundaries of the desired net.

Once a handset is in a net on the map, you can click and drag it to another net. This will remove it from the first net and add it to the second net. Alternately, if you hold down the Shift button while you are dragging it to the second net, the handset will remain assigned to the first net but also be added to the second net and appear where you drop it. IMEIs can appear on the map multiple times since they can be assigned to multiple nets.

6.4.2 Selecting a Net Between Multiple Options
If the IMEI is dragged to an area where two or more nets overlap, a pop up window will appear asking you to select which net you want to add the IMEI to (see Figure 24). To add an IMEI to multiple nets, simply repeat the process.

6.5 Map Display Filtering

6.5.1 Declutter Nets Window
This function serves to filter the map display by temporarily removing from the map any nets not needed for current mission planning. The declutter procedure does not permanently delete nets. To declutter nets, use the following procedure:
Click on the **View** menu selection.

Select the **Declutter Nets** option to bring up the *Declutter Nets* window (see Figure 25).

Left-click desired net(s) to drop from current map view.

**NOTE:** Ensure there are checks in the checkboxes next to the nets you want displayed. The checkboxes should be empty for nets you do not want to display. You can also **Select All** nets or **Clear All** nets for display with their respective buttons.

When completed, click on the **OK** button.

**NOTE:** To bring net back into current map view, simply repeat procedure in reverse, adding nets by left-clicking appropriate box.

### 6.5.2 Filtering by Net List Checkboxes

An alternate way to drop individual nets from the current map view is to uncheck the checkboxes in front of nets in the **Nets** list (see Figure 26). Left-click the check box again to recheck the box and return nets to map view. You can also display all nets by clicking on the **Select All** button at the bottom of the **Nets** pane. You can remove all nets from the display by clicking on the **Deselect All** button at the bottom of the **Nets** pane.
### 6.5.3 Quick Clear of All Handsets and Nets

To quickly filter the display of all handsets and nets from the current map view, left-click on **Show Net/Handset Layer** to uncheck the box. **Show Net/Handset Layer** is located under the map (see Figure 27). Unchecking the box removes all nets and handsets from current map view, but leaves the checkbox selections in the **Nets** pane intact. Left-click the box again to return nets and handsets to the map view.

![Figure 27: Map View with Net/Handset Layer Filtering](image)

### 6.5.4 Display IMEI on Map

The controls for how IMEIs are displayed on the map are located under the map area to the right of the **Show Net/Handset Layer** control.

There are three options for IMEI representation on the map.

- **Full IMEI** – All 15 digits of IMEI displayed
- **Last 4 of IMEI** – Last 4 digits of IMEI displayed
- **No IMEI** – IMEI display off

These settings apply to the IMEIs of all handsets displayed on the map. Based on user preference, click on your desired display option. The radio button with the green dot indicates the current selection.
Section 7 – Using User Management to Troubleshoot Handsets

7.1 Getting IMEI and Software Load Information

For the handset that is attached to the User Management computer, you can pull information off the handset into the User Management application, such as IMEI and the current software load. Pulling the IMEI off the handset saves you time and the potential for error with having to enter the 15 digits in manually. To view the handset’s IMEI and software load, use the following procedure:

- Click on the **Tools** menu selection.
- Select the **Attached Handset** option to bring up the **Handset Properties** window (see Figure 28).
- Select a handset, if multiple handsets are attached. If no handsets are displayed but there is one attached, click on the **Refresh Handsets...** button.
- Select the handset type, either RO or ROA.
- Click the **Get Info** button. The handset IMEI and software load will be displayed in the middle of the window.

![Figure 28: Attached Handset Properties Window](image.png)
7.2 Checking Data Usage

The handset sends data in short bursts. Each handset is allotted a maximum of 100 KB of Short Burst Data (SBD) usage per billing cycle. SBD data is only used when a handset is communicating with the Net Manager, such as when submitting assignment change requests or when querying the Net Manager via User Management. If you have been using a handset for communication with the Net Manager, you may want to monitor its SBD usage. To check current data usage for the attached handset, use the following procedure:

☐ Click on the **Tools** menu selection.
☐ Select the **Attached Handset** option to bring up the **Handset Properties** window (see Figure 28).
☐ Select a handset, if multiple handsets are attached. If no handsets are displayed but there is one attached, click on the **Refresh Handsets**… button.
☐ Select the handset type, either RO or ROA.
☐ Click the **Get Info** button. The SBD Information is located at the bottom of the window.

The most important information is the **Total Bytes** used in the **Current** billing cycle row. If this number reaches 100 KB, you will not be able to use that handset for data until the next billing cycle begins. The **Current Billing Date** at the bottom indicates the day of the month when the next billing cycle will begin. Currently, the billing cycle changes on the 1st of each month, so each month your available SBD per handset will be reset to 100 KB.

If the SBD usage for a given handset reaches 75% of the maximum, a warning will be displayed in User Management to alert you. If you reach, or are close to, the maximum SBD usage for a specific handset, it is recommended that you switch to another handset for SBD tasks until the next billing cycle begins.

7.3 Using AT Utility to Determine Handset Configuration

AT is an abbreviation for Attention. AT commands are an industry standard used to control communications devices. The **AT Utility** window provides a way to pull data off the handset and determine its current configuration. To initiate the **AT Utility**, use the following procedure:

☐ Click on the **Tools** menu selection.
☐ Select **AT Utility** to bring up the **AT Utility** window (see Figure 29).
☐ The AT Command should be GetNets. Leave the Parameters field blank.
☐ Select a handset, if multiple handsets are attached. If no handsets are displayed but there is one attached, click on the **Refresh Handsets**… button.
Click on the **Submit** button.

The results (see Figure 29) include the attached handset’s IMEI, the handset’s software version, and the nets loaded on the handset (the nets are the last five numbers in the results string).

![AT Utility Window](image)

**Figure 29: AT Utility Window**

### 7.4 Error Logs
Log files are created that list every action that occurs in the User Management application. Log files are stamped with the date and time and can assist in troubleshooting if there is a problem with the User Management or Net Manager assignment.
7.4.1 Viewing Log File

Users have the ability to view log files, but this is not designed to be a routine action. The log files can get very long and are not formatted for the User Management user. New log files will automatically be started when the previous log reaches 5 MB. To view the log, use the following procedures:

- Click on the **Logging** menu selection.
- Select the **View Log File** option to open the *Select Log File To View* window.
- Select the log file you want to view, such as “FieldApp_Rolling_Log” and click on the Open button.
- A rolling log will be displayed. This log can be exported to assist in troubleshooting.

7.4.2 Clearing Log File

Users have the ability to delete the log file. If you export a log file it is recommended that you clear the log so a new log file will be started. To clear the log file, use the following procedure:

- Click on the **Logging** menu selection.
- Select **Clear Log File**.
- You will see the **Files Deleted Successfully** message. Click **OK**.

**Caution:** Selecting the Clear Log option will delete the log without any further prompts. Do not select it unless you are sure you are ready to delete the log.

7.4.3 Exporting Log File

Users have the ability to export log files. This can be a useful aid in troubleshooting. If you are having issues, you might be asked to export you log file and provide it to an FSR. To export the log file, use the following procedure:

- Click on the **Logging** menu selection.
- Select the **Export Log File** option.
- Select the location where you want the exported log file to be saved in the *Browse For Folder* window.

**NOTE:** In the location you select, a Logging folder will be created, if not already there. The exported version of the log will be in the Logging folder.

- When completed, click **OK**.
- You will see the **Files Copied Successfully** message. Click **OK**.
- You can now navigate to the Logging file in the location you selected. The log in the folder will be saved as FieldApp_Rolling_Log.
NOTE: The log file always exports with the same name, so it will overwrite any previously exported log files in the same location. If you would like to save the previous log files, they need to be renamed before beginning the export process.
Section 8 – Updating Password, and Delegated Handsets and Nets

8.1 Changing Password
The password for your User Management user name must match the password associated with your permissions on Net Manager. Occasionally your password will expire and an FSR will provide you with the new password associated with your Net Manager account. You will then need to change your User Management password to remain in sync. To change your User Management password, use the following procedures:

- Click on the **File** menu selection.
- Select the **Change Password** option to open the *Change Password* window.
- Enter your old password, your new password, and your new password again to confirm it.
- When complete, click on the **OK** button.

**NOTE:** Do not change your password unless directed to by an FSR. If you need to initiate a change to your password, coordinate with an FSR so your corresponding password on Net Manager can be updated to remain in sync.

8.2 Exporting Data for Remote Delegation
Occasionally there may be changes to the sets of handsets and/or nets that are delegated to you to manage. If you are co-located with an FSR, he can make these updates locally on your User Management computer. However, if you are not collocated with an FSR, these delegation updates will have to be made remotely. For the current version of User Management, this requires sending a configuration file to the FSR which he will update and send back. The configuration file you export will contain all of your settings and configurations. This ensures that you do not have to start over if your delegated assets changes. To export your data to send to an FSR for remote delegation, use the following procedures:

- Click on the **Delegation** menu selection.
- Select the **Export My Updated Data** option to open the *Save As* window (see Figure 30).
- By default, your file will appear in the Logging file within the User Management file structure. Select the location on your computer where you want to save your file.
- When complete, click on the **Save** button.
- You will see the **User data successfully exported** message. Click **OK**.
- Provide the exported file to an FSR.
NOTE: Any changes made after the configuration file is exported will be lost when the updated file is imported.

![Figure 30: Saving Export File for Remote Delegation](image)

8.3 Importing Data for Remote Delegation

Once the FSR has updated the delegated assets in your configuration file, he will return it to you. Importing this file in the User Management application allows you to return to your settings and configurations as of the exported state, with the exception of any handsets and nets that were added or subtracted during the FSR’s delegation. To import your updated data, use the following procedures:

- Ensure that the updated configuration file from the FSR is accessible from the User Management computer.
- Click on the Delegation menu selection.
- Select the Import My Updated Data option to open the Open window (see Figure 31).
- Select the location on your computer where the updated configuration file is saved. It should have a *.fat extension.
- Click on the Open button.
- You will see the User data imported successfully message. Click OK.
Figure 31: Importing File for Remote Delegation
### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLOS</td>
<td>Beyond Line-of-sight</td>
</tr>
<tr>
<td>C2</td>
<td>Command and Control</td>
</tr>
<tr>
<td>C2PC</td>
<td>Command and Control Personal Computer</td>
</tr>
<tr>
<td>DTCS</td>
<td>Distributed Tactical Communications System</td>
</tr>
<tr>
<td>FAT</td>
<td>Field Application Tool</td>
</tr>
<tr>
<td>FSR</td>
<td>Field Service Representative</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IMEI</td>
<td>International Mobile Equipment Identity</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>NM</td>
<td>Net Manager</td>
</tr>
<tr>
<td>OTH</td>
<td>Over-the-horizon</td>
</tr>
<tr>
<td>OTM</td>
<td>On-the-move</td>
</tr>
<tr>
<td>PLI</td>
<td>Position Location Identification</td>
</tr>
<tr>
<td>PTT</td>
<td>Push-To-Talk</td>
</tr>
<tr>
<td>RO</td>
<td>Radio Only</td>
</tr>
<tr>
<td>SBD</td>
<td>Short Burst Data</td>
</tr>
<tr>
<td>TTL</td>
<td>Time To Live</td>
</tr>
</tbody>
</table>
Distributed Tactical Communications System (DTCS)

Distribution Statement D: Distribution authorized to the Department of Defense and U.S. DoD contractors only. Proper authorization is required prior to the release of any such information to parties other than program participants who have signed appropriate confidentiality or nondisclosure agreements. Other requests shall be referred to NSWC Dahlgren Division, Code Z14.